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TAUS0611541EN00Solution ID 0 Solution Usage

Description
What port name should be used for the Pi6000?

Solution
The port name required depends on what type of printing is being set up.  In most cases, the TCP/IP address can be used. Please refer to the  Network User
Manual  , beginning on page 4-13, for further details.
Note:  To view the above PDF(s), Acrobat* Reader must be installed.  Acrobat Reader can be downloaded for free from the Adobe* Web site at:
[[http://www.adobe.com/products/acrobat/readstep2.html| URL http://www.adobe.com/products/acrobat/readstep2.html]]

* Trademark ownership information 

TAUS0620838EN00Solution ID 0 Solution Usage

Description
Is there a listing of parts for the Pi6000?

Solution
Please refer to  bulletin 2441   for cables and other parts for the Pi6000.
Note:  To view the above PDF(s), Acrobat* Reader must be installed.  Acrobat Reader can be downloaded for free from the Adobe* Web site at:
[[http://www.adobe.com/products/acrobat/readstep2.html| URL http://www.adobe.com/products/acrobat/readstep2.html]]

* Trademark ownership information 

TAUS0623899EN00Solution ID 0 Solution Usage

Description
Are Microsoft* Windows 2003 drivers available?

Solution
PCL* drivers are provided with Windows 2003 server for most of the controllers.  However, the Windows XP version of the drivers can also be used with
Windows 2003 server.  Printer drivers can be found in the "Library" section of MyKonicaMinolta.com.  Users without MyKonicaMinolta.com access can
download drivers from the public web site: 
[[http://kmbs.konicaminolta.us/eprise/main/KMBS/Support_Center/Home| URL http://kmbs.konicaminolta.us/eprise/main/KMBS/Support_Center/Home]]

* Trademark ownership information 

TAUS0627386EN00Solution ID 0 Solution Usage

Description
Is AS/400* printing supported?

Solution
AS/400 support is available for digital copiers/printers that are connected to controllers which have PCL* emulation.  Refer to the the  Copier Bulletin #
01-MB-27   for answers to the most common questions about AS/400 printing.  The P4Server  brochure   and  specification sheet   provide additional
information.
Note:  To view the above PDF(s), Acrobat* Reader must be installed.  Acrobat Reader can be downloaded for free from the Adobe* Web site at:
[[http://www.adobe.com/products/acrobat/readstep2.html| URL http://www.adobe.com/products/acrobat/readstep2.html]]

* Trademark ownership information 

TAUS0630987EN00Solution ID 0 Solution Usage

Description
Current printer driver(s) for the Pi6000.

Solution
Printer drivers can be found in the "Library" section of MyKonicaMinolta.com.  Users without MyKonicaMinolta.com access can download drivers from the
public web site: 
[[http://kmbs.konicaminolta.us/eprise/main/KMBS/Support_Center/Home| URL http://kmbs.konicaminolta.us/eprise/main/KMBS/Support_Center/Home]]

TAUS0632563EN00Solution ID 0 Solution Usage

Description
The Pi6000 can be PINGed, but cannot be setup with its TCP/IP* utility.
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Solution
CAUSE:  Incorrect hardware hub).

SOLUTION:  Make sure the hub can communicate with the Pi6000 at 10Mbits/sec.  The Pi6000 NIC is not capable of communicating at 100Mbits/sec.

* Trademark ownership information 

TAUS0632564EN00Solution ID 0 Solution Usage

Description
When running the Remote Panel Utility for DOS, diagonal lines scroll across the screen

Solution
Cause: The ANSI.SYS driver must be loaded in when the PC is booted. 

Solution: Add the following line to the CONFIG.SYS file: 
device=C:\ [path] \ansi.sys where [path] is the location of the ansi.sys file on the hard drive of the PC.

examples:
device=C:\WINNT\system32\ansi.sys
device=C:\windows\command\ansi.sys
 Link  

TAUS0632565EN00Solution ID 0 Solution Usage

Description
An SMTP error occurs while attempting to set the IP address on the PI6000's NIC.

Solution
The communication speed with the hub must be 10 Mbits/second. The Pi6000 NIC will not support 100 Mbits/sec as a transmission speed.

TAUS0632566EN00Solution ID 0 Solution Usage

Description
How to print a network configuration page.

Solution
The easiest way to print a configuration page is to create a network error. Disconnect the power from the Pi6000, then disconnect the network cable and
reconnect the power without the network connection. After a couple of minutes, a network configuration page will be printed.

TAUS0632877EN00Solution ID 0 Solution Usage

Description
How to determine the TCP/IP* address of the Pi6000 print controller.

Solution
To determine the TCP/IP address of the Pi6000 print controller, perform the following:
1.  Make sure the Pi6000 is properly attached to the copier/printer, then unplug the network cable.
2.  Power OFF/ON the controller and a configuration page containing the TCP/IP address will be printed.
Notes:
    a.  The TCP/IP controller utility (  utiltcp.zip  ) can also be used.
    b.  The  Network User's Manual   describes the use of the TCP/IP utility beginning on page 4-20.
    c.  To view the above PDF(s), Acrobat* Reader must be installed.  Acrobat Reader can be downloaded for free from the Adobe* Web site at:
[[http://www.adobe.com/products/acrobat/readstep2.html| URL http://www.adobe.com/products/acrobat/readstep2.html]]
    d.  To open the ZIP file(s), WinZip* must be installed.  WinZip can be downloaded from the [[WinZip website| URL http://www.winzip.com/ddchomea.htm]].
The file can either be saved to disk or opened.  It is recommended to download the ZIP and open from the local computer to view.

* Trademark ownership information 

TAUS0634260EN00Solution ID 0 Solution Usage

Description
Is there a Windows XP driver available for the Pi6000 print controller? What can I do as a work around if one is not available?

Solution
Pi6000 drivers for Windows XP are not available. Please use the Windows 2000 driver as a work around, but note that some functionality may be lost.
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TAUS0634965EN00Solution ID 0 Solution Usage

Description
How to get PageScope accessories and PageScope Cabinet.

Solution
The part number for PageScope Cabinet only is 7650-049. For information on scanning to FTP with PageScope Cabinet, please see section 9.2 of the
PageScope Cabinet Operation Manual, which is linked below.

For the entire PageScope Suite (PageScope Cabinet, Net Care, EMF Plug-Ins, NDPS Gateway) the part number is 7650-0001-10.

For more information on PageScope, visit: [[http://www.pagescope.com| URL http://www.pagescope.com/]]

The PageScope Cabinet  Operation Manual  is also available.

TAUS0635012EN00Solution ID 0 Solution Usage

Description
How to restore factory default settings.

Solution
Use jumper JP5 on the NIC. Please refer to page M-26 of the  Pi6000 service manual  for details.

TAUS0635018EN00Solution ID 0 Solution Usage

Description
After clearing a malfuntion code of C-1330, a C-1840 print controller error is indicated on the control panel.  After shutting down the copier and the print
controller, it now prints normally from the workstation.

Solution
CAUSE:  The C-1840 is a side effect of the engine code (for example, C-1330).  When the printer reports a fatal error it shuts down communication with the
controller.  The Pi6000 does not know what has happened, so it reports a communication error, C-1840, which cannot be displayed until the original problem
has been corrected.

SOLUTION:  Once the cause of the original code (such as C-1330) has been resolved, the C-1840 can be reset and no further action will be needed.

TAUS0635055EN00Solution ID 0 Solution Usage

Description
Pi6000 finisher support.

Solution
The Pi6000 offers full support for the FN3 finisher only.

TAUS0635741EN00Solution ID 0 Solution Usage

Description
Item numbers for Parts or Service Manuals.

Solution
Please refer to this  publications list .

Note:    
To view the above PDF, Acrobat* Reader must be installed.  Acrobat Reader can be downloaded for free from the Adobe* web site at:
[[http://www.adobe.com/products/acrobat/readstep2.html| URL http://www.adobe.com/products/acrobat/readstep2.html]] 
* Trademark ownership information 

TAUS0636014EN00Solution ID 0 Solution Usage

Description
When installing the print driver in *Windows 98 it is possible to browse to the printer but the queue cannot seen or selected.

Solution
This can be caused if the printer has a space in its name or the printer name is longer than 10 characters. The space can be replaced by an underscore or
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dash if desired.

* Trademark ownership information 

TAUS0636966EN00Solution ID 0 Solution Usage

Description
When printing from *PageMaker 6.5 running on *Windows XP, the application crashes when the PPD is selected in the print dialog.

Solution
Adobe states that PageMaker 6.5x [[may not meet expectations in Windows XP| URL http://www.adobe.com/support/techdocs/328682.html]], since it was
released prior to Windows XP and was not developed for this operating system.

If problems are encountered with PageMaker 6.5 in Win XP, it is recommended that users upgrade to PageMaker 7.  Adobe has tested PageMaker 7.0 in
Windows XP, as well as Windows 2000, NT with Service Pack 5 or 6, ME, and 98. Adobe Technical Support fully supports and researches issues that arise
when PageMaker 7.0 is used in these Windows operating systems.

* Trademark ownership information 

TAUS0637533EN00Solution ID 0 Solution Usage

Description
Slow printing of PDF files.  When printing scanned images (PDF format) the print process is very slow.

Solution
Make sure that the check box for "Print as image" is NOT checked when printing from Acrobat Reader.

TAUS0637678EN00Solution ID 0 Solution Usage

Description
Is print spooler software is available for use with Windows 95/98/ME?

Solution
WLPR Spooler is still available. WLPR Spooler version 5.0b is attached below, as is a PDF file containing a quick start guide for installing the utility. For more
information on this release of WLPR Spooler please refer tothis link"http://home.arcor.de/Heil-Consulting/download.htm" 
Another spooling program is available for download from the University of Texas.  Please refer to the following link
"http://www.utexas.edu/academic/otl/software/lpr/"

TAUS0637695EN00Solution ID 0 Solution Usage

Description
How to completely remove a printer driver in Microsoft* Windows 2000 or Windows XP.

Solution
When removing a printer from the Printers folder, the printer driver file is not removed from the hard disk drive. This following describes a procedure to use if a
printer driver file is corrupted:

WINDOWS 2000
WARNING:  If using Registry Editor incorrectly, serious problems may occur that will require reinstallation of the operating system.  Microsoft/KMBS cannot
guarantee that problems can be solved that result from using Registry Editor incorrectly.  Use Registry Editor with extreme caution.

1.  Remove the printer using the Printers folder in Windows 2000. 
2.  In Windows 2000, in Control Panel, double-click Administrative Tools, double-click Services, and then stop the Spooler service. 
3.  Run Registry Editor (Regedt32.exe) and go to the following subkey (note that this is all one path, which has been wrapped for readability):

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Print\
Environments\Windows NT x86\Drivers\Version-3\ 

Note:  Version-3 is Windows 2000, and   is the name of the printer to be removed.
4.  Note the values on the right and write down the file names. 
5.  With the printer driver key selected, click Delete on the Edit menu. 
6.  Go to the following directory and delete the printer driver files noted in step 4:

%SystemRoot%\System32\Spool\Drivers\  

Note:    is Intel, MIPS, Alpha, or PPC.  See the following table to match the folder with the version of Windows for which the printer driver was installed: 
w32x86\0 : Intel Windows NT 3.1 printer drivers
w32x86\1 : Intel Windows NT 3.5x printer drivers
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w32x86\2 : Intel Windows NT 4.0 printer drivers
w32x86\3 : Intel Windows 2000 printer drivers
Win40\0 : Windows 95 printer drivers 
Note:  If unable to delete the files and folders in the above directory structure after stopping the spooler service because of an error message that the files are
in use (such as, Rasddui.dll), set the startup type for the Spooler service to Disabled, restart the computer, and then attempt to delete the files and folders
again.  After deleting the files, restore the Spooler startup to Automatic.
7.  In Windows 2000, in Control Panel, double-click Administrative Tools, double-click Services, and then start the Spooler service. 
8.  If reinstalling a printer, use the Printers folder.
9.  Delete the %windir%\inf\oem?.inf file that is associated with the removed printer driver.  This removes the printer from the printer selection list when adding
new printers. 
Note:  In addition to the steps listed above, it may be necessary to delete the printer's associated unidriver (Rasdd.dll, Pscript.dll, or Plotter.dll).  If printing has
been initialized or if a process is using this file, it will be locked open and cannot be deleted.  The file can be renamed or the system can be restarted to free
up the driver.  Refer to the Printer.inf file to see which unidriver is used by a particular printer.

WINDOWS XP
Windows XP adds a user interface feature to delete driver files so the steps for Windows 2000 are no longer necessary.  To delete printer driver files in
Windows XP:
1.  Click Start, and then click Printers and Faxes.
2.  On the File menu, click Server Properties.
3.  On the Drivers tab, click the printer driver to be deleted, and then click Remove.

* Trademark ownership information 

TAUS0640951EN00Solution ID 0 Solution Usage

Description
Information for parts number (vertical transport unit).

Solution
See  KOM050113  for details.
Note:  To view the above PDF, Acrobat* Reader must be installed.  Acrobat Reader can be downloaded for free from the Adobe* Web site at:
[[http://www.adobe.com/products/acrobat/readstep2.html| URL http://www.adobe.com/products/acrobat/readstep2.html]]

* Trademark ownership information 

TAUS0643880EN00Solution ID 0 Solution Usage

Description
When print jobs are sent from the Pi6000, the Job List light comes on momentarily and "C-1842 Controller Error" is briefly indicated, then the job disappears.

Solution
CAUSE:  Copy Track is not enabled for the copier or insufficient memory is installed.

SOLUTION:  Please check to see whether Copy Track is turned on for the printer.  If Copy Track is enabled for the printer and a print job is received without a
valid Account Number, the job will be processed by the controller but rejected by the copier.  The copier will delete the print job and briefly display the C-1842
error code.  To verify that this is the cause, turn off Copy Track for the printer and send a print job to the machine.
If Copy Track is not enabled, lost print jobs can also be caused by insufficient memory.  Please refer to  Bulletin 3105   for further details.
Note:  To view the above PDF(s), Acrobat* Reader must be installed.  Acrobat Reader can be downloaded for free from the Adobe* Web site at:
[[http://www.adobe.com/products/acrobat/readstep2.html| URL http://www.adobe.com/products/acrobat/readstep2.html]]

* Trademark ownership information 

TAUS0643930EN00Solution ID 0 Solution Usage

Description
Jobs with multiple page sizes cannot be printed from multiple paper trays when using Adobe* Acrobat Reader.

Solution
CAUSE:  Adobe Acrobat Reader (3.0 and later) prints all pages of a PDF file to the paper tray used for the first page. 

SOLUTION:  To work around this limitation, print all of the pages that have one page size, then print all the pages that have another page size.  Refer to
[[Adobe Reader support| URL http://www.adobe.com/support/products/acrreader.html]] on the Adobe site.

* Trademark ownership information 

TAUS0644016EN00Solution ID 0 Solution Usage

Description
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Printer spool file errors when printing to the Konica Minolta print controllers using Corel* Draw 12.

Solution
CAUSE:  This error is commonly caused by the \WINDOWS\SPOOL folder or \WINDOWS\SYSTEM32\SPOOL becoming too full or unable to accept new
data.

SOLUTION:  If this occurs, ensure that the SPOOL folder in the WINDOWS folder is purged of old print jobs.  The spooler can also be disabled in the printer
driver properties.  For most printer drivers, click Start, Settings, Printers.  Click the printer icon and click File, Properties. Click Details, Spool Settings.  Enable
the Print Directly To Printer check box. 
Note:  To easily find the SPOOL folder select "Start"== "Search" and  enter "Spool" as the key word for the search.

* Trademark ownership information 

TAUS0644656EN00Solution ID 0 Solution Usage

Description
All sets of the print job are stapled together.  (For example, when 5 sets of a print job of 4 pages, stapled and sorted is sent from the workstation, the output is
all 5 sets of the 4-page document is stapled together.

Solution
CAUSE: Incorrect setting in driver.

SOLUTION: Always make sure that the collate check box is unchecked when the print dialog comes up after print is selected.

Note: With some *Windows 2000 drivers, it is also possible to print properly by turning off the "Advanced Printing Features" option.  However, this disables
certain printer features.

* Trademark ownership information 

TAUS0644839EN00Solution ID 0 Solution Usage

Description
Jobs do not print without pressing the print key.

Solution
CAUSE:  Firmware problem.

SOLUTION: The permanent solution is to upgrade the copier with the latest firmware. The temporary solution is to replace the staple cartridge. Please see
bulletin 2617D  for additional information.

TAUS0645368EN00Solution ID 0 Solution Usage

Description
Unable to connect to a shared LPR port on a Windows* 2000 server (Event ID: 2005, LPR print monitor failed to open a temporary file while spooling output to
port IP address: the system may be low on disk space or the Spool directory is write-protected.)

Solution
PROBABLE CAUSES:
 
1.  Inappropriate permissions to the spool folder that is located at %SystemRoot%\System32\Spool\Printers by default. 
    a.  On the Printers folder, click Server Properties on the File menu, and then click the Advanced tab to check the permissions on the spool folder. 
    b.  Configure default permission on the Printers folder and all folders below it. For additional information about the default NTFS spool permissions, click
the article number below to view the article in the Microsoft Knowledge Base: 
148437 (http://support.microsoft.com/kb/148437/EN-US/) Default NTFS Permissions in Windows NT  
    c.  Confirm the permissions on the system root and volume root, and then make sure that the Everyone group has at least Read permissions. For additional
information, click the article number below to view the article in the Microsoft Knowledge Base: 
152763 (http://support.microsoft.com/kb/152763/EN-US/) File Delete Child Directory Permission in NTFS  
    d.  Run the following command to confirm that the destination LPR port that is created is actually a port to a valid Line Printer Daemon (LPD) server:

lpq -s server IP address or host name -p print queue name
For example, to test to see if a physical printer with the IP address of 192.168.1.15 and a queue name of RAW is available as an LPD, run the following
command line:

lpq -s 192.168.1.15 -p RAW
Depending on the printer, when you run the command, either a blank line, or the following data is displayed: 
Windows 2000 LPD Server
Printer \\192.168.1.15\RAW
Owner Status Jobname Job-Id Size Pages Priority

2.  A print component such as TCP/IP printing was added and the service pack that the operating system is currently running on was not re-applied. In this
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case, the spooler files are mismatched. 

3. The Everyone group does not have Read permissions. 

For details, please see Microsoft* Knowledge Base Article Q245033:
http://support.microsoft.com/default.aspx?scid=kb;en-us;Q245033

* Trademark ownership information 

TAUS0646113EN00Solution ID 0 Solution Usage

Description
When using the "lock job" feature is there a limit to the number of jobs that can be locked and, if so, how many?

Solution
There is a limit, which depends on whether the machine is set to "Printer Priority" or "Copier Priority." The number of jobs that can be held is described in
Marketing Bulletin #98-06 . 

Note:
1. This bulletin was written about the Di620/Di520, but also applies to the Di450, Di470, and Di550.

2. To view the above PDF, Acrobat* Reader must be installed.  Acrobat Reader can be downloaded for free from the Adobe* web site at:
[[http://www.adobe.com/products/acrobat/readstep2.html| URL http://www.adobe.com/products/acrobat/readstep2.html]] 
* Trademark ownership information 

TAUS0646824EN00Solution ID 0 Solution Usage

Description
Does Konica Minolta provide support for Equitrac* products?

Solution
For Equitrac technical support information please visit [[http://www.metrics.com/Support/| URL http://www.metrics.com/Support/]] or contact trained Support
Engineers by telephone at 519.885.2458, by fax at 519.746.7931 or via E-mail at support@metrics.com

Note:  Technical Support is available Monday through Friday, 8 AM to 6 PM, EST.

*[[Trademark ownership information| FILE V:\\TEXT\\TRADEMRK.TXT NEW]]

TAUS0646937EN00Solution ID 0 Solution Usage

Description
Following a Novell* NDPS or iPrint installation, the Windows* print driver is configured with default settings ONLY on the client workstation.

Solution
CAUSE:  Novell NDPS or iPrint drivers are migrated from the Novell server to clients in a non-configured format.  This is because the driver is not actually
installed on the Novell server.  In the Novell environment, the server simply holds, and then pushes the non-configured driver files to the client.  In a Windows
server environment, the Windows driver is installed on the server and can be configured prior to roll out to the clients.

SOLUTION:  It is possible to roll-out configured drivers from in a Novell environment.  Novell's ZenWorks* allows the Novell administrator to create a snapshot
of a client workstation before and after the driver is installed and configured.  This snapshot can then be migrated to the user's workstations resulting in a
configured driver installation.

Using ZenWorks to migrate a configured driver will vary based on Netware version, ZenWorks version, NDPS version and Windows client version.  Therefore
step by step instructions to perform this operation are not available.  The Novell administrator at the location would be responsible for implementing this
procedure.

[[Third party print driver configuration applications| URL http://www.printerpropertiespro.com]] for Novell are also available.  Please consult the vendor(s) for
implementing these solutions.

* Trademark ownership information 

TAUS0646938EN00Solution ID 0 Solution Usage

Description
Following a Novell* NDPS or iPrint installation, the Windows* print driver is configured with default settings ONLY on the client workstation.

Solution
CAUSE:  Novell NDPS or iPrint drivers are migrated from the Novell server to clients in a non-configured format.  This is because the driver is not actually
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installed on the Novell server.  In the Novell environment, the server simply holds, and then pushes the non-configured driver files to the client.  In a Windows
server environment, the Windows driver is installed on the server and can be configured prior to roll out to the clients.

SOLUTION:  It is possible to roll-out configured drivers from in a Novell environment.  Novell's ZenWorks* allows the Novell administrator to create a snapshot
of a client workstation before and after the driver is installed and configured.  This snapshot can then be migrated to the user's workstations resulting in a
configured driver installation.

Using ZenWorks to migrate a configured driver will vary based on Netware version, ZenWorks version, NDPS version and Windows client version.  Therefore
step by step instructions to perform this operation are not available.  The Novell administrator at the location would be responsible for implementing this
procedure.

[[Third party print driver configuration applications| URL http://www.printerpropertiespro.com]] for Novell are also available.  Please consult the vendor(s) for
implementing these solutions.

* Trademark ownership information 

TAUS0649956EN00Solution ID 0 Solution Usage

Description
When print jobs are sent from the controller, the Job List light comes on momentarily and then the job disappears. Copy Track for the printer is enabled on the
copier.

Solution
CAUSE:  Incorrect number used.  If Copy Track is enabled for the printer and a print job is received without a valid Account Number (NOT Access Code), the
job will be processed by the controller but rejected by the copier. The copier will delete the print job and briefly display the C-1842 error code.

SOLUTION:
Use the account number (instead of the access code) when sending print jobs.

TAUS0656768EN01Solution ID  Solution Usage

Description
 What Konica Minolta print drivers will come bundled with Windows Vista? 

Solution
  The following list of drivers were included in a recent Vista release candidate and should be representative of what is included in the final retail product.
These include a large number of legacy Konica, Minolta and Konica Minolta drivers. Unless otherwise noted, the majority of the drivers are Postscript  
    
  Konica  
       
  7020/IP-421  
  7022/IP-422  
  7022/IP-423  
  7025/IP-421  
  7030/IP-421  
  7033/IP-402  
  7033/IP-411  
  7035/IP-421  
  7040/IP-402  
  7040/IP-411  
  7045/IP-431  
  7050/IP-201  
  7050/IP-301  
  7050/IP-302  
  7055/IP-303  
  7055/IP-304  
  7060/IP-302  
  7060/IP-304  
  7065/IP-303  
  7065/IP-304  
  7075/IP-601  
  7085/IP-602  
  7130/IP-422  
  7130/IP-423  
  7135/IP-423  
  7145/IP-423  
  7150/IP-302  
  7150/IP-304  
  7155/IP-511  
  7165/IP-511  
  Force 50/IP-301  
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  Force 50/IP-302  
  Force 60/IP-302  
  Force 60/IP-304  
  Force 65/IP-511  
  Force 75/IP-601  
  Force 85/IP-602  
  KL-3015  
    
  Konica Minolta  
      
  KM 1050  
  KM 350/250/200  
  KM 500/420  
  KM 7085/IP-602  
  KM 7145/IP-432  
  KM 7222/IP-424  
  KM 7228/IP-424  
  KM 7235/IP-424  
  KM 7255/IP-511A  
  KM 7272/IP-511A  
  KM 750/600  
  KM 920  
  KM C250  
  KM C351  
    KM C352/C300      
    KM C450      
    KM Di2010 PCL5e      
    KM Di2010f PCL5e      
    KM Di2510 PCL5e      
    KM Di2510f PCL5e      
    KM Di3010 PCL5e      
    KM Di3010f PCL5e      
    KM Di470 PCL5e      
    KM Di552 PCL5e      
    KM Pi7200E PCL5e      
    KM mc2450 PPD      
    KM mc5450 PPD      
    KM mc7450 PPD      
    Magicolor 2350      
    Magicolor 3300 PPD      
    Magicolor 7300 PPD      
    PagePro 9100 PPD    
          
   Minolta     
        
   Minolta Di2010 PCL5e     
   Minolta Di2010f PCL5e     
   Minolta Di2510 PCL5e     
   Minolta Di2510f PCL5e     
   Minolta Di3010 PCL5e     
   Minolta Di3010F PCL5e     
   Minolta Di3510 PCL5e     
   Minolta Di3510f PCL5e     
   Minolta Di470 PCL5e     
   Minolta Di552 PCL5e     
   Minolta Pi1802/1502e PCL5e     
   Minolta Pi3500     
   Minolta Pi3502 PCL5e (MS)     
   Minolta Pi5500 (MS)     
   Minolta Pi5501 PCL5e (MS)     
   Minolta Pi6200     
   Minolta Pi6500e PCL5e     
   Minolta Pi6500 Pro PCL5e (MS)     
   Minolta Pi7200e PCL5e     
   Minolta Pi7500Ver2 PCL5e (MS)     
   Minolta Pi8500Pro PCL5e      
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Pi6000

Description
Mail Merge does not split after installing Macro to split it.

Solution
 CAUSE: Incorrect section data was input into the macro. 
  
 SOLUTION: Check the bottom status bar of the word window of the original document. The number after Sec. should be input into the macro. Make sure that
the Macro security is set to low in order to run.   
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